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Introduction
Main Areas
HigginSoft Names 3.1a is a convenient place to quickly look up names, addresses, and phone numbers. 
The program is broke down into three primary parts:

Personal
A scrolling browse table is used to show everyone in your list. As you scroll down the list of names the 
person's address and phone numbers are displayed, as well as their email address and web site location.
If you have a scanned picture of the person you can also have it displayed. A dialing button lets you 
automatically dial one of three numbers for the highlighted name. Another button is available to print out 
an envelope for the highlighted name.

Business
A scrolling browse table is used to show all the businesses in your list. As you scroll down the list the 
company names (and the company president/owner) the company's address, email address and web site
location is displayed. By selecting a tab you can see all the phone numbers and contacts for the business 
name that is highlighted. A dialing button lets you automatically dial the highlighted phone number in the 
Phone List or the Contacts List.

Emergency
A scrolling browse table is used to show all the emergency agencies in your list. The scrolling list shows 
the name and phone number of the agency. In this list, you can also put down places and phone numbers
you will be if you are going out for the evening. You can then print this list out to leave with whoever is in 
charge of the kids that evening (baby sitter, parent, oldest child, etc.) A dialing button lets you 
automatically dial the highlighted phone number.

Other Areas
Defaults
The defaults area is where you put information that stays constant throughout the entire program or for an
extended amount of time. This includes things like the return address that will be printed on envelopes, 
control codes and communications port for your modem, what sections you might want to automatically 
open when you start the program, and a city, state/providence, and postal code that will automatically be 
entered when adding a new name or business entry.

Reports
A number of reports are available for the Personal and Business sections. These include Detailed reports,
Phone List reports, Envelope printing, and Mailing Label printing. There is only a single report available 
for the Emergency section.

Messages
The messages area works like a mini scheduler. You are able to insert any number of messages for 
anyone or any company, including the date and time. You can then have all messages displayed for any 
range of days. This display will sort the messages by date and time.



Getting Help
You can get help from different sources, depending on what type of help you are after, and where you are 
in the program.

Instant Help
There are two places to get instant help:

Status Bar - at the bottom of the screen is a status bar that will tell you where you are or what type of
information a field is looking for. In the figure below is the status bar help for the Add button in the 
Names List.

Tooltip - when the cursor settles over certain places on the screen, primarily buttons, a small yellow 
window opens that gives a brief description of what the button (or tab, area, etc.) does.

Online Help
There are three ways to get online help:

F1 Key - by pressing the F1 key, this help file will open up. Depending on where you are, you will be 
taken to the Contents page or to the page that is dealing with where you are.

Question Button - on most windows is a purple question button. This button will open this help file 

and take you to the page dealing with the window you are working in.  There is also the purple 
question mark on the toolbar that will do the same thing.

Help Menu - the last option on the menu bar is the word Help.  Clicking on 
Help will open the following menu selections.

 
· Contents will take you to the Contents page of this help file.
· Search for Help On... will take you to a list of keywords. From there you search for the subject 

you are looking for. On the top line start typing the subject matter you are looking for. If the topic 
you type is listed as a keyword, that word will be highlighted in the list of keywords below.

For more information on how to use online help select How to Use Help from the Help Menu.

Go to:
Customer Support



Browse Table
A browse table or browse list is a list of all the records in your database. A highlight bar will indicate which 
item on the list has the focus.

For more detailed information select the following topics:
Scrolling the List
Adding, Editing, and Removing Records
Tabs (Browse)
Hot Fields
Closing a Browse Table



Scrolling the List
Scroll Bar
If the list is longer than the area display area a scroll bar will appear on the right side so you can move 
down the list. You can move up and down the list by clicking and holding on the arrows at the top and 
bottom of the scroll bar, or you can click and hold on the little square (called a thumb button) on the scroll 
bar and move the square up and down the scroll bar. If you move the button about two-thirds the way 
down the scroll bar, the list will move about two-thirds down the list.

Locator
The browse tables of the three main sections (Personal, Business, and Emergency) have an incremental 
locator. What this means is that when you press a letter key on the keyboard the list will move to the first 
entry in the list that starts with that key. If you were looking for ‘Jones’, you would press the ‘J’ key. this 
will take you to the first last name that starts with ‘J’, whether it was ‘James’, ‘Johnston’, or ‘Jones’. As you
continue to type the name the highlight bar in the browse table will continue to move to the closest name 
that fits the entered parameteres. If you type 'Jo', using the above names, it would take you to 'Johnston'. 
Typing 'Jon' would then highlight 'Jones'.

Keyboard
There are several ways you can scroll up and down the browse list using the keyboard:

· Arrow keys - using the up or down arrow keys will move the highlight bar up or down one record 
at a time.

· Page Up/Page Down - pressing the PageUp or PageDown keys will scroll the list one page up or 
down. A page is determined by how many records can be displayed in the list at one time. If the 
list can display fourteen items then pressing PageDown will display the following fourteen entries 
in the list.

· Home/End - pressing the Home or End key will move the list to the first record or last record in 
the list. If there are a 150 entries in the list, pressing the Home key will move the highlight bar to 
record one. If you press the End key you will move to record 150.

Go to:
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Adding, Editing, and Removing Records

Using Buttons
Under the browse table are three or more buttons. The following buttons are used to add, edit or remove 
an entry. If you hold the mouse arrow over a button for a few seconds a small yellow window, called a 
tooltip, will tell you the button's purpose.

 Add - bring up a blank form to add a new entry.

 Edit - displays the highlighted entry in a form so you can make changes.

 Remove - deletes the highlighted entry from the list. Before an entry is deleted you will see the 
following:

 

If you press the OK button, then the highlighted entry is deleted. A note of warning is needed here. Once 
a record is deleted it is removed forever. There is no undelete.

Keyboard
Add - Insert key
Remove - Delete key

Mouse
Edit - Double-click on entry displayed in the list.

Go to:
Browse Table



Tabs (Browse)
The main browse table will usually be on a tab called 'General'. Some browse table windows may have 
additional tabs. These tabs display additional information about the highlighted entry on the general 
browse table. To see the information, make sure the entry you want the additional information on is 
highlighted and then click on the desired tab. The tab's title will give you an indication of what is contained
under that tab.

Go to:
Browse Table



Hot Fields
On some windows there may be fields that are related to the highlighted entry in the browse table. As you 
scroll down the browse list, these 'hot fields' will change accordingly. For example, when you are scrolling 
down a list of names, the hot fields that show the phone numbers will change to indicate the phone 
numbers that have been entered for the name that is highlighted in the browse table.

Go to:
Browse Table



Closing a Browse Table

 Clicking the Close button will close the window.

Go to:
 Browse Table



Forms
A form is used to add a record into your database, which, in turn, will be displayed in the forms respective 
browse table.The basic form will contain one or more labels with an entry field following each label. For 
example, a label may be titled, Name:, and next to it would be an entry field where you would insert a 
name.

For more information select the following topics:
Data Entry
Tabs (Forms)
Recursive Adds
Changing Records
Closing a Form



Data Entry
On most labels there will be a letter that is underlined. This underlined letter is called a 'hot key'. To 
access a hot key, hold down the Alt key (usually next to the space bar) and while holding down the Alt key
press the key that is underlined. This will move the cursor to the entry field following that label. For 
example, if you wanted to move to the entry field following Name:, then you would hold down the Alt key 
and then press the 'N' key. (This is annotated as 'Alt-N'). Letter case doesn't matter.

This type of field is called an 'entry field' and only allows a maximum number of characters to be put into it
and at times the entry must be in a certain format. Examples might be the Postal Code field which will 
only let you put in a ten-character entry and a date field that will only allow certain formats, such as 
54/3/21 or 54-3-21, and also makes sure that an incorrect entry isn't made, such as 96/13/32.

Other than entry fields mentioned in the previous paragraph, a form may have other types of fields:
· Check box - this will be a small box that allows you to put an 'x' in it when clicked. x This is also 

known as a 'logical' field or a 'true/false' field. The reason for this is that when clicked you are 
indicating that the label is true or that you are saying yes. If the box is unchecked that means the 
field is false or indicates a no answer. For example, if a check box that has a label 'Relative' is 
checked you would be indicating the person is a relative. If you leave it unchecked, or uncheck it 
by clicking on it once it has an 'x' in it, you are indicating the person isn't a relative.

· Radio button - this is a field that is related to other fields. This field is a small round circle and 
when selected puts a black dot in the circle. ¤ Within the group of fields only one field can be 
selected at a time. If you select a field that doesn't have the black dot in it, the black dow will 
move to it and will be removed from the field where it was previously. An example would be in an 
invoice program where the payment type might give the options of Cash, Check, Credit Card, or 
COD. Only one payment type could be selected if these were set up with radio buttons.

· Text box - this is much like the entry field, but you are allowed a bit more flexibility, such as using 
multiple lines (word wrap is automatically built in) and even multiple paragraphs. These have a 
maximum number of characters, but are usually quite large, such as 1000 characters. A text box 
will have a vertical scroll bar so you can view any text that might be hidden.

· Image box - this allows you to add a clip art graphic or scanned image. See Adding an Image in 
the Names topic for detailed information.

Go to:
Forms



Tabs (Forms)
If there are a lot of fields to be filled on a form the fields may be spread over several tabs. These tabs will 
be displayed at the top of the entry section. Tabs are labeled according to what information is being asked
for. In this way, you can skip any section that doesn't apply. If you are entering in the name of a single 
man or woman this person may not have any dependants so you can skip the Dependant tab.

Go to:
Forms



Recursive Adds
Recursive adds means the form continually stays active for new records to be added until you actually 

exit the form. (See: Closing a Form) When you click on the Save button  your entry is saved and you
are given an opportunity to add more records or to return to the browse table. You will see the following:

 

If you select the 'Yes' button all fields are cleared, and hidden fields that may have been unhidden are 
rehidden, and you are returned to the first field on the front tab. 

Entries do not show up in the browse table until the 'No' button is selected. 

Go to:
Forms



Changing Records
When changing an entry you previously entered simply move to the field(s) you want to change and make
your changes.

 If you want to save your changes click the Save button and you will be returned to the forms 
respective browse table.

 If you want to cancel making any changes click the Cancel button. If you have made any changes 
you will get the following warning:

 

If you simply forgot to click the Save button, click the Yes button. If you don't want to save any of the 
changes click the No button. If you want to stay in the form click the Cancel button.

Go to:
Forms



Closing a Form

A form is closed by clicking on the Cancel button.  What happens when you close a form depends 
on whether you were adding or editing a record.

Adding New Records
If you have been entering records and are on a blank form, all previous records will be saved and the 
form will close. If you have been entering a new record but haven't clicked the Save button the following 
message will be displayed:

 

If you simply forgot to click the Save button, click the Yes button. If you don't want to save any of the 
changes click the No button. If you want to stay in the form click the Cancel button.

Changing a Record
If you had clicked the Edit button from the form's respective browse table to get to the form and you didn't 
make any changes the form will close and return to the forms respective browse table. If you made any 
changes to any of the fields you will get the same warning displayed above. If you simply forgot to click 
the Save button, click the Yes button. If you don't want to save any of the changes click the No button. If 
you want to stay in the form click the Cancel button.

Go to:
Forms



Menus and Buttons
You maneuver around in HigginSoft Names by use of either menus or buttons. Menus help you get to 
one section or another. Buttons generally help you maneuver within that section.

Menus
The Main Menu is located on the menu bar close to the top of the screen and looks like this:

 Each of these menu options have a pull down menu called 'submenus'. You gain 
access to the submenus by either clicking on the main menu title or selecting the menu options ‘hot key’.

File
This is the menu option you will use the most. It is where you get to the main areas of the program. 
It's submenu is shown below:

 

If you click on any of the four top items (Personal, Business, Emergency, Defaults) you will be taken 
immediately to the browse table for that section. The fifth line, Print, will take to a second submenu. 
This is indicated by the little arrow head to the right of Print. The submenu is shown below:

 

Because there are so many different report options for the Personal List and Business List they are 
broken down to another submenu. There is only one report available for the Emergency List so 
clicking on it automatically prints a list of emergency agencies and numbers. Clicking on Registration 
Form prints out the registration form needed when you register your copy of HigginSoft Names. It's a
bargain at just $15. Below are the submenus for the Personal List and Business List:

                                                     

                              Print Names List Submenu                                        Print Business List Submenu

Detail Lists print everything for every name on the list. For the Personal List you can choose whether 
to have pictures included. An Abbreviated Detail List leaves out the relationship check boxes. Phone 
Lists only prints the name or company and listed phone numbers. Mailing Labels will let you print 
mailing labels on any label format you have. You will have to define borders and label sizes. This will 
allow you to print and number of labels across a page or down a page. Envelopes print single-feed 
#10 envelopes. From the print menu envelopes are printed for every name. You can print a single 
envelope from the Personal List or Business List browse tables.

Edit
The Edit menu gives you the Cut, Copy, and Paste options most Windows programs offer. The 



standard Windows hot key options also work here (Ctrl-X to cut, Ctrl-C to copy, Ctrl-V to paste). 
Preview Option determines whether the Print Preview option is active when printing a report. If it is 
checked then a screen image of the report will be displayed when you choose to print a report. You 
are given the option to send the report to your printer or to cancel the report from the print preview 
screen. If it isn't checked, then a report goes directly to your printer. The Edit menu is displayed 
below:

 

Window
The Window menu allows you to tile or cascade any open windows within HigginSoft Names. The 
Windows menu also lists which windows are open within the program. In the figure below all four 
sections are open with the Defaults Form having the focus (the top most window). To give the focus to
one of the other windows simply click on the one you want from the Windows menu.

 

Help
See Getting Help for detailed information on this section.

Buttons
The following figures show the different buttons you will see in HigginSoft Names with a short description 
of the buttons purpose.

 Displays a help window for the part of the program you are in at the time. See Getting Help.

 Closes a browse table window.

 Saves the current record in a form.

 Cancels and closes a form.

 Opens a blank form to add a new record. See Browse Table.

 Opens the highlighted record in a browse table to be viewed or edited. See Browse Table.

 Deletes the highlighted record in a browse table. See Browse Table.

 Opens the Defaults Form so the default city, state and/or zipcode can be changed.



 Prints an envelope for the highlighted record in a browse table.

 Dials the phone number of the highlighted record.

 Opens the Query-by-Example Wizard.

 Resets a browse table after using the Query-by-Example Wizard.

 Inserts a new image.

 Removes the displayed image.



Toolbar
The Toolbar is under the Menu bar at the top of the page. It is designed to help you navigate through the 
program without having to use the menu. It also has tools to help you navigate the browse tables. All of 
this is done through buttons. Leaving the mouse cursor temporarily over a button will display a tool tip. 
Below are the buttons found on the toolbar and a short description of what the button is for:

 

A B C D E

A) Opens the Personal Names List.

B) Opens the Business List

C) Opens the Emergency Phone Numbers List

D) Opens the Appointments List

E) Opens the Defaults Form

 

F G H I J K

F) Moves the highlight bar on a browse table to the first record

G) Scrolls up the browse table one full page from the highlight bar

H) Moves the highlight bar up one record

I) Moves the highlight bar down one record

J) Scrolls down the browse table one full page from the highlight bar

K) Moves the highlight bar on a browse table to the last record

 

L M N

L) Inserts a new record into the active list (browse table)

M) Allows the highlighted record on a browse table to be edited

N) Deletes the highlighted record on the browse table

 

O P

O) Opens the help file for the current window that has focus

P) Exits. If you are in a Form it will close and return you to its browse table. If you are in a browse table it 
will exit the program.





Defaults Form
The Defaults Form is used to hold default information that is used for certain parts of the program. This 
includes the City, State/Province, Country and Postal Code fields used when entering new names or 
businesses; the return address to be used when printing envelopes, and modem settings when using the 
dialer. Access to these different areas is accomplished by clicking on their tab.

The Defaults Form can be called up two different ways. One is from the File Menu on the menu bar and 

the other is by clicking the Defaults button on the Personal List and the Business List.  

For more detailed information select the following topics:
Default Entry Fields
Default Return Address
Default Dialer Codes
Open Windows
Directories



Default Entry Fields
The default entry fields are accessed by the Entry tab on the Defaults Form. This is the first tab and is the 
default tab when the form is opened. You will see four fields: City, State/Province, Postal Code and 
Country. See the figure below:

 

When entering a large number of names or businesses you may find that a majority of the entries have 
the same city, state\province, country and/or postal code. By filling in these fields you can have them 
automatically entered into the Personal Form or Business Form. Below is a sample of how I would fill this 
form:

 

Below is a sample of the Personal Form with the defaults inserted:

 

These entries are not carved in stone. That is, you can move to any of them and change them. When 
don't need one or more of the default fields to automatically fill in the the Personal Form go the Defaults 
Form and delete or change the entry. The default entry fields only work when adding a new entry to the 
Personal List or Business List.

Go to:



Defaults Form



Default Return Address
The second tab on the Default Form is where you put the return address you want to use when printing 
envelopes. If you don't want a return address printed on your envelopes leave it blank. Below is a sample 
filled out form:

 

Go to:

Defaults Form



Default Dialer Codes
Before you can use the dialer you need to set up the program so it can talk to your modem. There is 
nothing difficult about this and the default settings listed here will work with 99% of those who will use this 
feature. The figure below will show the settings you will probably use:

 

Comm Port - this is the communications port where you modem is set for. The options here are COM1 
through COM6. Clicking on the small down arrow next to the field will give you a drop down list for you to 
choose the correct Comm port. If you don't know what communications port you are using click on the 
Modem icon in your Windows control panel.

Dial Time - this refers to how much time to allow you to pick up the phone once there is a connection. 
Make adjustments as needed.

Dial Prefix - This is the modem command to instigate dialing.    Normally the default of “ATDT” is sufficient.
If you have a “pulse” line instead of “tone”, the command must be “ATDP”.

Dial Suffix - This is an optional modem command to be sent after the phone number.    Normally this will 
be left blank. If your modem is on a different extension than your user’s phone, then this command could 
transfer the modem’s outgoing call to the extension.The system automatically sends a carriage return 
after the entire command.

Hangup Command - This is the command to hangup the modem. Normally the default of “ATH” is 
sufficient.The system automatically sends a carriage return after the entire command. If you leave the 
Hangup Command blank, then the hangup support code will not be generated.    This is especially useful 
if you include the “H” to hangup as the last element in your Dial Suffix.

Go to:
Defaults Form



Default Open Windows
The Open Windows tab gives you a choice of having one or more sections of HigginSoft Names open 
automatically when you start the program.

 

If you check the Open Personal check box, when you start the program the Personal List will 
automatically open. If Open Business is checked, then the Business List will automatically open. If Open 
Emergency is checked then the Emergency List will automatically open. You can have one, two or all 
three checked.

Go to:
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Directories
The Directories tab lets you enter the path where you normally keep your graphic images that you will 
insert into the Personal section. You will need to enter the complete directory path, including the drive 
letter and the subdirectory where you keep your graphic images. Regardless what you enter here, you will
still be given the opportunity to go to any directory on your hard drive when you select the Insert Image 
button on the Personal Form. If there is no directory entered the current directory (the one you installed 
this program) will be used.

 

Go to:
Defaults Form



Personal Section
The Personal section is probably where you will spend the most of your time in the program. This is 
where you keep the list of names, addresses, and phone numbers of your family, friends, coworkers, 
church members, business associates, etc. You get to this section by choosing Personal under the File 
menu.

For more detailed information select the following topics:
Personal List
Personal Form



Personal List
When first opening the Personal List you will see the following screen:

 

General Tab
The white area is the browse list. This will display the names that you enter. You will use the first button to
bring up the Personal Form to add names. If you insert an image to the name you have entered it will be 
displayed in the upper right hand corner region. Below that is where the phone numbers will be displayed.
Under the browse list the address, email address, and web site of the person will be displayed. As you 
scroll through the browse list, the image, phone numbers, and address sections will change to show 
which ones belong to the highlighted name. 

See Browse Table for more information of using browse tables.

Below is the same screen after several names have been entered:

 

Appointments Tab
Clicking on the Appointments tab will display the following window:



  

Here you can insert appointments relating to this person or use it as a mini-scheduler. Clicking on the Add
button brings up the Appointments Form:

 

The Date and Time fields automatically display the current date and time, but these can be easily 
changed. When entering the date use the format of yyyy/mm/dd or yyyy-mm-dd (mm is month, dd is day, 
yy is year). You can also select a date from a calendar by clicking on the calendar icon. If you type in the 
month and day (mm/dd) then move to the Time field, the current year will be automatically inserted. For 
the time field use the format of hh:mm (hh is hour and mm is minutes). The AM or PM is changes by 
highlighting the A or P and changing it. If you enter a time but do not put in the AM or PM, AM will be 
inserted automatically.

The Appointment field is a free form entry field. You can enter multiple lines and paragraphs. Text is 
automatically wrapped to the next line and new paragraphs can be inserted by hitting the Return or Enter 



key.

After the appointment is saved the Appointments List will look like the image below:

 

If needed, you can read appointments that are not shown by using the horizontal and vertical scroll bars.

See Appointments for information on viewing all appointments for a particular day or range of days.

The following buttons are used with the Personal List:

 Calls up the Personal Form to add a new name to the Personal List or a appointment to the 
Appointments List.

 View and/or edit the highlighted name or appointment. Calls up the Personal Form or Appointments
Form.

 Remove the highlighted name or appointment.

 Calls up the Query-by-Example Wizard.

 Restores the browse list back to normal after a query.

 Print a #10 envelope for the highlighted name.

 Dial a phone number for the highlighted name.

 Calls up this help file.



 Close the window.

 Open a calendar window to select a date.

Go to:
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Personal Form
When first calling up the Personal Form it will look like the following:

 

It is broken down into the following sections:

General - names and address of the person and spouse

Phone Numbers - home, work, fax, mobile, and beeper numbers. Also email address and world wide web 
site.

Relationships - show what the relationship this person is to you; family, friend, business associate, 
coworker, church member, or other. Also indicate if this person is on your Christmas card list.

Dependants - dependant's name, relationship, and birthday.

Dates - birthday of this person and spouse, and anniversary date.

Comments - any additional information you want to keep a record of.

Image - a scanned image of this person.

If you call up the Personal Form by clicking on the edit button on the Personal List, then the Personal 
Form will be filled out with the information for the name that was highlighted on the Personal List.

See Forms on information on how to use a form.

Go to:
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Personal Form: General
When adding a new name to the Personal List, the Personal Form will look like the following:

 

The General tab includes the following fields:

· First - first name of the person you entering information on.

· Spouse - first name of this person's spouse.

· Last - this person's last name. This is a mandatory field.

· Business - the business name this person is associated with. Use this primarily for business 
associates.

· Address - the first address line is the primary address line, namely the street address, P.O. Box 
number, etc.

· Address - this for a second address line. This is seldom used except for businesses, but it's 
included here just in case its needed.

· Apt No. - apartment number, if there is one.

· City - city of the above address

· State/Province - this is for countries that have are divided into states or provinces, such as USA, 
Canada, Mexico.

· Postal Code - The postal code field will accomodate letter/number Canadian and European postal 
code formats, up to 10 characters.

· Country - this is an optional field. For addresses that are to the same country that you are in you 
should leave this blank, otherwise the country name will be printed on all your envelopes.

If you have set default names for the city, state/province, country and/or postal code by using the Defaults
Form, these will be automatically entered when adding a new name to the Personal List.

 The Default button is on the toolbar and can be called at any time. It calls up the Defaults Form to 
fill in the defaults for the city, state/province, country and postal code. If you change the Defaults Form 



while in the Personal Form, you will need to close the Personal Form and re-open it before the changes 
will be displayed.

Below is a sample of a Personal Form's General tab filled in:

 

See Forms for more information on how to use a form.

Go to:
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Personal Form: Phone Numbers
When you first go to the Phone Numbers tab this is what you'll see:

 

The Phone Numbers tab includes the following fields:

· Home - home phone number.

· Work - work phone number.

· Ext. - any extension needed to reach this person at the office.

· Fax - facsimile number.

· Mobile - cellular phone number.

· Beeper - pager number.

· Email - email address.

· WWW - location of world wide web site.

Phone numbers, especially the Home, Work, and Mobile fields, need to be entered they would be dialed if
you plan to use the Dialer. You can use separators, such as parenthesis and dashes. There are a 
maximum of 16 characters for phone numbers. The Dialer does not dial the work number extension. See 
Dialer for more information.

Below is a sample completed Personal Form Phone Numbers tab:



 

Go to:
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Personal Form: Relationships
The Relationships tab looks like the figure below:

 

This tab can be very helpful if you want to limit which names are displayed in the Personal List by using 
the Query-by-Example Wizard. When first opened the Personal    Form Relationships tab has the 
following fields:

· Relative - check here if this person is a relative.

· Business - check here if this person is a business associate.

· Friend - check here if the person is a friend.

· Work - check here if this person is a coworker.

· Church - check here is this person is a member of your church.

· Christmas List - check here if you want this person on your Christmas card list.

· Other - check here if you have a relationship with this person other than those mentioned above. 
Examples could be club or lodge members, political party associates, or people in your car pool, or
any other special group.

But these groups can be separated even further. Whenever you check any of the relationship check 
boxes a blank field will be displayed. The figure below shows the Relationship tab with all the check 
boxes checked:



 

In this blank field you could show that a relative is an aunt or cousin, put down the office any church 
member holds, or the type of Other relationship this person is. If you uncheck any check box its 
corresponding field will once again be hidden. If any data was entered in the field it will be automatically 
deleted. 

Go to:
Personal Form
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Personal Form: Dependants
The Dependants tab looks like the following before any dependants have been entered:

 

See Browse Table for detailed information on how to use a browse table.

Click on the Add button to insert a dependant to the Dependant List. When you do you will see the 
following form:

 

The Dependants Form has the following fields:

· Name - the first name of the dependant.

· Relationship - the relationship of the dependant (i.e. son, daughter, step-daughter, foster-son, etc.)

· Birthday - the dependant's birthday. The date must be in one of the following formats: yy/mm/dd, 
yy-mm-dd, yyddmm.

Below is a sample Dependants Form that's been filled in:



 

The Dependants Form supports recursive adds. When finished click the Cancel button. Below is a sample
Dependants List that's been filled in:
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Personal Form: Dates
The Dates tab is straight forward and looks like this:

 

The Personal Form Date tab only has three fields:

· Birthday - the birthday of the person you put in the First field under the General tab.
· Spouse's Birthday - the birthday of the person you put in the Spouse field under the General tab.
· Anniversary - the wedding anniversary of the the people you put in the First and Spouse fields 

under the General tab.

Date formats must be entered in one of three formats. mm = month, dd = day, yyyy = year

· yyyy/mm/dd (1955/3/25 or 1978/8/6)
· yyyy-mm-dd (1955-3-25 or 1978-8-6)

Note: You can put in United States formated dates (mm/dd/yyyy), but they will be converted to the above 
formats. You can experiment with different formats to see how they work. You will get an error if you enter 
a date that is out of range, such as putting 14 for the month or 32 as the day.

Go to:
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Personal Form: Comments
The Comments tab looks like the following figure:

 

This a place to put any additional comments about this person (or family) that you may want to keep on 
record. It could be anything from the fact that he borrowed a wrench or that she is the president of the 
Lady's Auxiliary at church.

You can do some paragraph formatting, such as starting new paragraph's or using tabs. Word wrap is 
automatic. Press the Enter key to start a new paragraph and the tab key to indent a paragraph.

If the text is longer than can be displayed use the scroll bar to move to where you need to go. You can 
scroll up or down by clicking on the up or down arrow on each end of the scroll bar. You can also move 
the thumb button up and down the scroll bar to move the text. If you move the thumb button half way 
down the scroll bar the text will move half way down. You can also use the up and down arrow keys.

Go to:
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Personal Form: Image
When you first click on the Image tab on the Personal Form you will see the following screen:

 

In the process of adding, removing, or resizing an image you will use these two buttons:

 Add a graphic image.

 Remove a graphic image.

Adding an Image
To add an image click on the Add Image button. You will see the following window:

 

The directory that will be shown initially will be the same directory where you have HigginSoft Names 
installed. Click on the small down-arrow in the Drives: field if you need to go to a different drive to fined 
the graphics image you are looking for. Click on the directory name that holds your graphics files in the 
Folders: section. Scroll down to the exact graphic image in the File name: section.

The List files of type: section initially shows all graphic types that HigginSoft Names will accept (GIF, 
JPG, PCX, BMP). If you only want to have a particular type of graphic file listed in the File name: section 
then click on the small down-arrow in the List files of type: section. Once you have located and highlighted



the image you want click on the OK button. It will be inserted into the Image tab of the Personal Form.

 

To change a graphic image click on the Add Image button and follow the same procedures listed above. 
To remove the graphic image click on the Remove Image button.

Here are a few notes in relation to viewing, adding, changing, and removing an image.

¨ If the colors of the graphic image don't look quite right this is due to having your Windows palette 
set to 256 color or less. The palette can be changed through your Windows Control Panel, but 
you must be sure your graphics card can handle a higher color palette before you make any 
changes. If you have your Windows palette set to 256 color there is a quick fix that you can use.

· Save the Personal Form by clicking the Save button.

· From the Personal List, while a name with a graphic image displayed is highlighted, click on 
the Edit button to call up the Personal Form once again.

· Click either the Save or Cancel button on the the Personal Form.

¨ If you click the Add Image button when a graphic image is already displayed the current image 
will be removed. If you decide you want to keep the same graphic image that you had, click the 
Cancel button on the Choose a File window and then the Cancel button on the Personal Form.

¨ Once a graphic image has been added to the Personal Form the original graphic image does not 
have to be kept on your hard disk.The graphic image is stored in a compressed format within the 
HigginSoft Names data files.

Go to:
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Business Section
The Business section is where you list the various businesses you have to get in touch with. No more 
running to the Yellow Pages to continually look up a phone number. No more rifling through a stack of 
business cards to find the person you need to contact. No more going through files to find invoices to find 
the phone number to the sales department. This is where you keep the list of company names, 
addresses, and phone numbers along with phone numbers to different departments and special contacts 
of these different businesses. You get to this section by choosing Business under the File menu.

For more detailed information select the following topics:
Business List
Business Form



Business List
When first opening the Business List you will see the following screen:

 

General Tab
The white area in the General tab is the browse list. This will display the businesses that you enter. You 
will use the first button to bring up the Business Form to add businesses. As you scroll through the 
browse list, the address, email address (if any) and world wide web site (if any) will be displayed in the 
blank are below the list. The Phone Numbers and Contacts tabs will show the phone numbers and 
contacts for the highlighted business in the browse list. The Appointments tab shows the appointment 
dates and times you have made with this company.

See Phones and Contacts under Business Form for information on how to add phone numbers and 
contacts. The Phone Numbers tab and the Contacts tab include the dialer button to let your computer 
dial the highlighted phone number.

See Browse Table for more information on using    browse tables.

Below is the same screen after a business has been entered:



    

Appointments Tab
Clicking on the Appointments tab will display the following window:

 

Here you can insert appointments relating to this business or use it as a mini-scheduler. Clicking on the 
Add button brings up the Appointments Form:



 

The Date and Time fields automatically display the current date and time, but these can be easily 
changed. When entering the date use the format of yyyy/mm/dd or yyyy-mm-dd (mm is month, dd is day, 
yy is year). If you type in the month and day (mm/dd) then move to the Time field, the current year will be 
automatically inserted. For the time field use the format of hh:mm (hh is hour and mm is minutes). The AM
or PM is changes by highlighting the A or P and changing it. If you enter a time but do not put in the AM or
PM, AM will be inserted automatically.

The Appointments field is a free form entry field. You can enter multiple lines and paragraphs. Text is 
automatically wrapped to the next line and new paragraphs can be inserted by hitting the Return or Enter 
key.

After the appointment is saved the Appointments List will look like the image below:

 

If needed, you can read appointment messages that are not shown by using the horizontal and vertical 
scroll bars.

See Appointments for information on viewing all appointments for a particular day or range of days.

The following buttons are used with the Business List:

 Calls up the Business Form to add a new name to the Business List or appointment to the 



Appointment List.

 View and/or edit the highlighted business or appointment. Calls up the Business Form or 
Appointment Form.

 Remove the highlighted business or appointment.

 Calls up the Query-by-Example Wizard.

 Restores the browse list back to normal after a query.

 Print a #10 envelope for the highlighted business. 

 Dial a phone number for the highlighted business

 Calls up this help file.

 Close the window.

Go to:
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Business Form
When first calling up the Business Form it will look like the following:

 

It is broken down into the following sections:

General - business name and address along with the email address and World Wide Web site of the 
business.

Contacts - name, position and phone number of those you may need to contact within that business.

Phones - phone numbers and description of what the phone number is for (i.e. sales, fax, main office, 
personal affairs, etc.).

Comments - any additional notes.

If you call up the Business Form by clicking on the edit button on the Business List, then the Business 
Form will be filled out with the information for the business that was highlighted on the Business List.

Go to:
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Business Form: General
When adding a new business to the Business List, the Business Form will look like the following:

 

The General tab includes the following fields:

· Company - name of the business.

· Address - first address line (usually street address or P.O. Box)

· Address - second address line (if needed) for Suite number, building number or name, etc.

· City - city of the above address.

· State/Province - state or province for countries that have them.

· Postal Code - The postal code field will accomodate letter/number Canadian and European postal 
code formats as well. This holds a maximum of 10 characters.

· Country - For addresses in the country you are in you should leave this blank, otherwise the 
country name will be printed on envelopes.

· CEO - chief-executive officer, president or owner of the company.

· Email - email address for the company.

· WWW - World Wide Web site of the company.

If you have set default names for the city, state, and/or zip code by using the Defaults Form, these will be 
automatically entered when adding a new business to the Business List.

 The Default button is located on the toolbar and can be called up at any time. It calls up the Defaults
Form to fill in the defaults for the city, state/province, country and postal code. Note: If you call up 
the Default Form from the Business Form you will have to close and re-enter the Business Form 
before any changes will take place.

Below is a sample of a Business Form's General tab filled in:



 

See Forms for more information on how to use a form.

Go to:
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Business Form: Contacts
The Contacts tab looks like the following before any contacts have been entered:

 

See Browse Table for detailed information on how to use a browse table.

Click on the Add button to insert a contact to the the Contacts List. When you do you will see the following
form:

 

The Contacts Form has the following fields:
· Name - name of the contact.
· Position - job or position title of the contact.
· Phone - phone number to reach the contact.
· Ext. - phone extension (if any).

Below is a sample Contacts Form that's been filled in:

 



Go to:
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Business Form: Phones
The Phones tab looks like the following before any dependants have been entered:

 

See Browse Table for detailed information on how to use a browse table.

Click on the Add button to insert a dependant to the phone number to the Phones List. When you do you 
will see the following form:

 

The Phone Form has the following fields:

· Phone No. - a phone number to the business. If you plan on using the Dialer you will need enter it 
as you would want it to be dialed. You can use dashes and parenthesis or a slash. If it is long 
distance you will need to add the '1' prefix.

· Ext. - The phone extension (if any).

· Description - the section of the business that this phone number belongs (fax, sales, front office, 
etc.)

Below is a sample Phone Form that's been filled in:

 



The Phone Form supports recursive adds. When finished click the Cancel button. Below is a sample 
Phone List that's been filled in:

 

Go to:
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Business Form: Comments
The Comments tab holds one text field where you can add any comments about this business you need. 
It looks like the figure below:

 

Unlike other entry fields, you can add multiple lines and paragraphs. You can enter more information than 
what is visible in the window. The scroll bar on the right will let you scroll up or down to view additional 
information. To enter a new paragraph press the Enter key. You can also add tabs.

Go to:
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Emergency Section
The Emergency Section is where you can put emergency phone numbers together in one place for easy 
access. The idea of this section isn't only for agencies, like the police, fire department or poison control 
center, but also the phone numbers where you might be that night. In this way you can print out the list 
and leave it with the baby sitter. In cases of emergency, panic can set in and a person can become numb,
not being able to think of who to call or where to get the number. Or a person may not be able to find the 
phone book or know where to look in the phone book. Making a print out of emergency phone numbers 
and leaving the list by the phone or attached to the refrigerator can help speed up emergency attention. 
Another thing to remember, don't just tell the baby sitter where the list is, show her. Also, show the list to 
the kids, something could also happen to the sitter.

For more detailed information select the following topics:
Emergency List
Emergency Form



Emergency Phone Number List
When first opening the Emergency Phone Number List you will see the following screen:

 

The white area is the browse list. This will display the agencies you enter. You will use the first button to 
bring up the Emergency Number Form to add agencies. 

See Browse Table for more information of using browse tables.

Below is the same screen after some agencies have been entered:

 

The following buttons are used with the Emergency Phone Numbers List:

 Calls up the Emergency Form to add a new name to the Emergency List

 View and/or edit the highlighted name. Calls up the Emergency Form.



 Remove the highlighted name.

 Dial a phone number for the highlighted agency.

 Calls up this help file.

 Close the window.
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Emergency Number Form
When first calling up the Emergency Number Form it will look like the following:

 

It is broken down into the following sections:

General - name and phone number of the agency

Comments - any additional information you want to keep a record of.

If you call up the Emergency Number Form by clicking on the edit button on the Emergency Phone 
Number List, then the Emergency Number Form will be filled out with the information for the agency that 
was highlighted on the Emergency Phone Number List.

Go to:
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Emergency Number Form: General
When adding a new Agency to the Emergency Phone Number List, the Emergency Number Form will 
look like the following:

 

The General tab includes the following fields:

· Agency - the name of the agency.

· Phone Number - the phone number where the agency can be reached.    If you plan on using the 
Dialer you will need enter it as you would want it to be dialed. You can use dashes and parenthesis
or a slash. If it is long distance you will need to add the '1' prefix.

Below is a sample of an Emergency Number Form's General tab filled in:

 

See Forms for more information on how to use a form.

Go to:
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Emergency Number Form: Comments
The Comments tab holds one text field where you can add any comments about this agency you need. It
looks like the figure below:

 

Unlike other entry fields, you can add multiple lines and paragraphs. You can enter more information than 
what is visible in the window. The scroll bar on the right will let you scroll up or down to view additional 
information. To enter a new paragraph press the Enter key. You can also add tabs for paragraph 
indention.

Go to:
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Emergency Section



Query-By-Example Wizard
The Query-By-Example Wizard is a powerful search and filtering tool. With it you can list or print out 
names and businesses that fit certain criteria. Examples are:

· list or print family members only or just aunts and uncles

· names of those living in a certain state or not in a certain state

· coworkers only or church members only

· names on the Christmas card list only that live out of the city

· birthdays or anniversaries that fall in a certain month

You can do queries on a browse list or report. The only difference is that on a browse table you have to 
click a button to request a query. On a report, you are automatically given the option to print a queried 
report or not.

queries can be saved for future use. Once you tell the Query-By-Example Wizard you are finished you will
be asked if you want to save the query. This will allow you to call up the same query in the future without 
having to reselect the options. Saved queries can also be changed or deleted. Another thing to note is 
that each section that calls up the Query-By-Example Wizard has its own Saved Queries list.

On a browse table, the Query-By-Example is called up with the following button:  This brings up the 
following window:

 

On a report, after selecting the printer type and the report title, the same window appears. From this point 
on the Query-By-Example Wizard works the same for both the browse table and reports. An example of a 
filled Saved Queries list is below:



 

There are five buttons:

· Select - selects the highlighted saved query.

· Insert - adds a new query.

· Change - allows changes to the highlighted query.

· Delete - removes the highlighted query from the list.

· Close - cancels the Query-By-Example Wizard. On a browse table, this returns you back to the 
browse table. On a report it continues the report without using any query.

Inserting a New Query
Let's suppose you need to find all the names of those who live in the UK and Scotland. Click on the Insert
button to add a new query. You will see a new window much like the following:

 

The Fields to Evaluate list shows all the fields that can be queried. Scroll down using until you find 
Country in the list. Highlight it and click the Next > button. You will see the following screen:



 

You have eight choices to narrow down your query. Of course, all of them will seldom apply to every field, 
but these options are always available. Let's look at their functions, assuming you are entering 'UK' into 
the query field on the next screen.

· Is Equal To - this means that the field you are querying must be an exact match to what you input 
on the next screen. This would query for records with UK in the Country field.

· Is NOT Equal To - this means you are wanting everything, except the exact match to what you 
input on the next screen. This would query for all records that do NOT have UK in the Country 
field.

· Is Greater Than - this means you are looking for all values greater than what is entered on the next
screen. This would query for all countries that alphabetically are greater than UK, but would not 
include UK.

· Is Less Than - this means you are looking for all values smaller than what is entered on the next 
screen. This would query for all countries that alphabetically are less than UK, but would not 
include UK.

· Is Greater Than or Equal To - this means you are looking for all values that are equal or larger than
what is entered on the next screen. This is the same as Is Greater Than above, except it would 
include UK.

· Is Less Than or Equal To - this means you are looking for all values that are equal or less than the 
what is entered on the next screen. This is the same as Is Less Than above, except it would 
include UK.

· Begins With - this means you are looking for all values that begin with what you entered on the 
next screen. If you only put a 'U' in the country field you would get Uraguay and Uganda.

· Contains - this means you are looking for all values that contain what you entered on the next 
screen.

Since you are looking for UK only at this point, highlight the Is Equal To Query Operation and click the 
Next > button. You will see the next screen:



 

There are three radio buttons and a check field, as well as the entry field:

· Constant Value - use the value that is entered into the entry field as the matching criteria.

· Another Field - use the value that is in another field as the matching criteria.

· Expression - enter an expression as the matching criteria. See the Advanced Queries section.

· Compare Using Case Sensitive Matching - if this is checked and you enter 'uk' in the entry field, as
opposed to 'UK', then no matches would be found because 'UK' was entered in upper case.

In the blank field, enter UK. Make sure that the Constant Value radio button is checked and the check box
is unchecked. Click on the Next > button.

The next window appears:

 

If all the names of those living in the UK was all you were looking for then you could click the Finish button
and continue, but you need all the names of those in Scotland as well. The buttons to consider here are 
the AND and OR buttons. These are logical operators. AND means all conditions must be true. OR 
means at least one condition has to be true. If you click the AND button and then specified that you 
wanted Scotland as well, then there would be no matches, because there can be no one address in UK 
and Scotland.

Click the OR button. This will take you back to the Fields to Evaluate list. Choose Country again. Click the
Next > button. In the Query Operations list select Is Equal To and click the Next > button. Enter 'Scotland' 



in the entry field and click Next >. The following window appears:

 

Now, lets hypothetically consider something here. Suppose you wanted only names in London, UK and all
those in Scotland. If you added AND City Is Equal To London you wouldn't find any matches for names in 
Scotland. This is because the query would look for London, Scotland. To get this to work you would enter 
the AND City Is Equal To London after the Country Is Equal To UK and then add OR Country Is Equal To 
Scotland after it.

When you click the Finish button you will see the following message:

 

If you click Yes you will be prompted for a name to save the query under. You could enter, 'Names in UK 
and Scotland only'. If you click on No the query continues. If you click Cancel you are returned to the 
previous screen.

Changing a Saved Query
If you want to change an existing saved query, highlight the one you want to change in the Saved Queries
window and click the Change button. Make your changes and click the Finish button. The Query-By-
Example Wizard treats this like a new entry so you will be asked if you want to save it again. Make your 
choice and continue with the query operation.

Advanced Queries
If the preceding options don't let you filter the queries like you want you can manually enter in the 
functions you need. A good example of this is to find those who have a birthday or anniversary in a certain
month. Suppose you want to find all the people in the First and Spouse fields in the Personal Section 
have a birthday in August.

When you first open the New Query window you will see a Manual button. Click it. You will see the 
following screen:



 

To find a particular month, type MONTH. If you were looking for a particular year you would type, YEAR. 
The same with DAY. In this case you want the month of August, so type MONTH (. The field name must 
be in parenthesis. Now click on the small down arrow at the end of the Field List field. It will look like the 
screen below:

 

Scroll down until you find Birthday and double-click it. It will insert the programs internal variable 
(NAM:Birthday). Add the close parenthesis and ' = 8'. Since you are looking for the August birthdays for 
the spouse's as well type OR MONTH(. From the Field List find Birthday of spouse and double-click it. 
Add the close parenthesis and ' = 8'. Your screen should look like the one below:



 

Click the Finish button. Decide whether to save the query or not.

Removing Query Results

To remove the query results and bring a browse list back to normal, click on the reset button.  



Dialing
On certain browse lists where phone numbers are involved, you can have HigginSoft Names 
automatically dial the number for you. Before you can use the Dialer, you must set up the program to 
recognize you modem and add the connection codes necessary. This is easy to do. See Default Dialer 
Codes on how to do this.

The Dialer is called up by clicking on the Dial button:     

When the Dial button is clicked, before dialing you are given the option to make changes to the number 
before it is dialed:

 

If there are any prefix or suffix numbers that need to be added to the number, they can be added here, 
such as adding a '9' in front of a number to get an outside number or *70 to disable call waiting.

The Dialer works a little differently on different browse lists, but not much. On browse lists where only one
phone number is involved, after clicking the dial button the Please Verify Number... window comes up. 
Click on OK to dial or Cancel to return to the browse list.

From the Personal List you have one of three numbers you can dial: Home, Work, and Mobile. If there is 
no number entered for any of these catagories (such as 'Mobile', then no button will be displayed for that 
catagory. When you click on the dial button on the Names List you will see the following window:

 

Click on which number you want to dial and the Please Verify Number... window appears for you to make 
any changes you need before dialing.



Appointments
The Appointments section displays appointments that have been entered in the Personal and Business 
sections. When selected from the File menu option from the menu bar you will see the following:

 

Select the starting and ending dates that you want your appointments displayed. By default, both dates 
are the current date. You can change the dates by using the spin controls (the up/down arrow at the end 
of the field). The down arrow moves the date back on day at a time, the up arrow moves the date up one 
day at a time. You can also enter in the date by highlighting the date and entering in the new date you 
want. Use the format of yyyy/mm/dd or yyyy-mm-dd. Be sure not to put a date in the End Date field that 
precedes the Start Date field.

Click the OK button to show the appointments for the range of dates you entered. The Appointments List 
will be displayed showing the appointments for the dates in the range you entered in the previous form.

 

You will see a line at the top of the list that indicates which dates are included in the list. The list is 
displayed under two tabs. The Personal tab will show the appointments in the Personal section and the 
Business tab will show the appointments in the Business section. 

 Printing Appointments
You can print the appointment list by clicking on the Print button. Which list that is printed depends on 
which list is being viewed at the time. If you want to print both lists you will have to, first, click the 
Personal tab and then click the Print button and, secondly, click the Business tab and then click the 
Print button again.



Reports
Reports are called from the Files menu option on the menu bar. Several reports can be called for the 
Personal and Business sections that include detailed reports that show all the information on each record 
and simple phone lists or envelopes and mailing labels. There is only one report style for the Emergency 
section.

The first thing that needs to be mentioned is whether you want reports to show a preview of what will be 
printed or not. Under the Edit menu option on the menu bar is an option called Preview Option. When the 
program is started this is automatically checked. This means that before any report is printed a print 
preview will be displayed. If you don't want to see this, click on Preview Option which will uncheck it. That 
will mean that all reports will be automatically sent to the printer and will not show a preview.

Regardless of what report or what type of report you decide to print or whether you use the print preview 
option, you will see the following screen:

 

This allows you to change printers and causes the report to be formatted according to the type of printer 
you are using. Generally, you won't make any changes here.

Each of the reports have Query-By-Example attached to them. You can use this feature to print out 
selected records, such as only friends and relatives, or businesses in a particular state. This works a bit 
different than it does when called from one of the lists. When the Saved Queries window displays (see 
figure below) click the Close button if you want print all of the records. If you want to use one of your 
previously saved queries select one of the Query Description titles and click the Select button. If you want
to print a different query click the Insert button.

 

Many of the reports let you add your own title to the report. Before the title prints you will see a window 
much like the one below:



 

Click on the titles below to see the title forms for other reports:

Phone List, Business List, Business Phone List, Emergency Phone List.

If you want to change the report title, enter a new title name. If you want to use the default title name, click
the OK button without changing the default name. If you don't want a title name, delete the default name 
and leave it blank.

As the report is being formatted you will see the Generating Report window with a spinner indicating that 
the report is being generated.

 

See Print Preview for detailed information on the print preview screen.



Registering HigginSoft Names
Until you register HigginSoft Names you will see the following screen each time you start the program:

     

The number of trial days will count down until it has been 31 days or longer. If you have not registered 
within the 30 day trial period you will see the following screen:

 

To register, print out the registration form (found under the File/Print menu option on the menu bar) and fill
it in. To get the correct machine code follow these instructions:

 

Take note of the Machine Code number and the Date. These, and the name, are required to get the 
correct passcode.

To fill out this portion, start by clicking the Help option on the menu bar and then choosing Register:

 

This will display the Registration Information window:

 



1. Enter you name in the Name field that you want the program registered to. This must be your 
personal name. You can enter the address information if you want, but at this time it is unimportant.

2. This is the name that you will put in the Registration Name block on the Registration Form. 

3. Click on the Machine Code and Date button.  This will display the following screen:

 

4. Enter the top number into the Machine Code block on the Registration Form. Enter the bottom 
number into the Date block on the Registration Form.

5. Mail the Registration Form together with your payment to Ensign Systems. 

You will be mailed or emailed your passcode number. Be sure to copy it down and save it in a safe place 
where you will remember where it is. When you receive your passcode number you enter it into the 
program as follows:

1. Call up the Registration Information window by selecting Register from the Help option on the menu 
bar.

2. Click on the Enter Registration Passcode button.  

3. That will display the following screen:

 

Click the Yes button.

4. That will display the following screen:

 

The number of trial days left will vary. Click the Yes button.

5. You will see the following screen:



 

Enter the passcode you were sent in the mail or email.

If all goes well you will see the following Congratulations! window:

 

Once you get the Congratulations screen you should never be bothered by having to enter the passcode 
again, unless you change the Registration Name field in the Registration Information window. 

If things don't go well you will see the following screen:

 

There are three main reasons that can cause this to happen.

1. The passcode has been typed in wrong.

2. You have changed the Registration Name in the Registration Information window. This is usually 
caused by getting the machine code number and date while the Name field still displays 
UNREGISTERED VERSION and then you put in your name and address afterwards.



Customer Support
CompuServe: 106305,635
America Online (AOL): ENsignPub

Internet: 106305.635@compuserve.com

Fax: 0181-776-8477



Legal Stuff
License & Disclaimer

Programmed by:    HigginSoft Software, © Copyright HigginSoft Software 1996, 1997. All Rights Reserved.
HigginSoft Software    REMAINS THE SOLE PROPRIETOR OF THIS PROGRAM

LICENSE      
By breaking the seal of the diskette package or by your initial use of the software you agree to the following:                    
This license of use does not allow you to distribute, copy, reproduce, or resell any,    or part of any or all of the files in the HigginSoft 
Names Package. 
The violation of this license agreement will terminate your agreement with HigginSoft Software at which time you must destroy any 
copies you may have and erase the files from your hard drive. This is copyrighted material and as such it is protected by the 
governing copyright laws!
This License to use this HigginSoft Software program is a single computer license.
YOU MAY:

Make one copy of the disk for yourself for back up purposes.
YOU MAY NOT:

Distribute the code or any file included in the HigginSoft Names package.
Install this program on more than one computer without the express permission from HigginSoft Software . 
Sell or lend the program to any other person, copy the program or any part of the program for commercial or non commercial 
distribution EXCEPT AS PROVIDED IN THE LICENSE AGREEMENT.    
Disassemble, DECOMPILE OR CHANGE THE PROGRAM IN ANY WAY.

LIMITED WARRANTY
HigginSoft Software warrants the software distributed is free of any defects in materials and workmanship for a period of 90 days. 
HigginSoft Software will replace any damaged software at no extra cost, provided you return the software along with proof of 
payment within 90 days of purchase.

DISCLAIMER OF WARRANTY
THIS SOFTWARE    IS DISTRIBUTED "AS IS" WITHOUT WARRANTY OF ANY KIND.      IN NO EVENT SHALL HigginSoft Software
OR ANY PERSON ASSOCIATED WITH HigginSoft Software BE LIABLE OR RESPONSIBLE FOR ANY PROBLEMS TO THE 
HARDWARE, SOFTWARE, LOSS OF DATA, OR ANY CONSEQUENTIAL LOSSES THAT MAY ARISE FROM THE USE OF THIS 
HigginSoft Software    PROGRAM. 



Registration Form
for HigginSoft Names

REGISTRATION FORM
HIGGINSOFT NAMES VERSION 3.1a

Please complete the detail required below and post to:
ENSIGN SYSTEMS
21 Tredown Road,
Sydenham
London, SE26 5QQ

Alternatively, you may telephone your order to 0181-778-2871 if you wish to pay by credit card 
(Mastercard\Visa) or fax it to 0181-776-8477.

-------------------------------------------------------------------------------------------------------
Please tick your choice:
a) Please register this Version of HigginSoft Names
and send any minor updates via Compuserve or AOL £17.50

OR
b) Please register this version & send the current version
on 3.5" HD Floppy (£17.50 + £2.00 postage\handling) £2.00
Name ________________________________ Telephone___________________________

Address ______________________________ Compuserve ID ______________________

_____________________________________ AOL ______________________________

_____________________________________

Postcode _____________________________

REGISTRATION NAME 
_________________________________________________________

MACHINE CODE AND DATE 
____________________________________________________

-------------------------------------------------------------------------------------------------------
I enclose a cheque\money order for the sum of £____________ made payable to Ensign Systems



OR
I WISH TO PAY BY CREDIT CARD Mastercard\Visa (delete as applicable). Please debit my 
credit card for the sum of £__________.

Card No ______________________________________ Expiry Date _________________

Signature ______________________________________ Date _______________________



 



 



 



 



Highlight bar

A blue band on a browse table that indicates which record has focus.



Detailed Reports

Reports that print all the information for the selected names or businesses.



Phone Lists

Reports that print only the name or company name and their related phone numbers.



Database

A collection of records relating to a single topic.



Record

A collection of fields relating to a single object.



Field

A single entry relating to a record.



Filling In Dates
Date fields take the format of yyyy/mm/dd or yy/mm/dd. If you select the later, however, the program, in 
most instances, assumes you mean the current century. If you want February 2, 1898 you must use the 
yyyy/mm/dd/ format. In this example you can enter 1898/2/2 or 1898/02/02. You could also enter 
02021898, but if you enter 221898 you will get an error in that the program would think you were asking 
for the 18th day of the 22nd month. Next to every date entry field you will find this icon:     Clicking on 
this icon will bring up a calendar that you can use to select a date.

 

The calendar will automatically display the current date. Using the left and right arrows under the Month 
and Year sections will change the calendar one month or year at a time. Once you have found the date 
you want, click on the date and that date will automatically be filled in into the entry field. In the example 
above, if you click on the '28' the date field will be filled in as 1996/10/28.

Note: United States date formats (mm/dd/yyyy) can be used also, but the program will convert them to the
UK/European format shown above.




